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Safety

This chapter includes:

®  ELECLICAL SATELY oottt sss bbb s bbb st bbb s bbb e st banen 10
O OPErALIONAL SAFELY ..ottt sssss s s s sss s s s s s s s s bbbt nssssnses 12
®  MAINTENANCE SAFELY ..o s s bbb s b s s nsas 14
©  PLINEEN SYMIDOLS ...ttt sttt b s e s s b e e bbb s bbb e a b b et nes 15
e  Environmental, Health, and Safety Contact INfOrmation ... 16

Your printer and the recommended supplies have been designed and tested to meet strict safety
requirements. Attention to the following information ensures the continued safe operation of your Xerox
printer.
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Safety

Electrical Safety

Please read the following instructions carefully before operating your printer. Refer to these instructions
to ensure the continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These
include safety agency evaluation and certification, and compliance with electromagnetic regulations
and established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox®
materials only.

Note: Unauthorized alterations, which can include the addition of new functions or connection of
external devices, can affect the product certification. Please contact your Xerox representative for
more information.

General Guidelines

A\ WARNINGS:
e Do not push objects into slots or openings on the printer. Touching a voltage point or shorting
out a part could result in fire or electric shock.

e Do not remove the covers or guards that are fastened with screws unless you are installing
optional equipment and are instructed to do so. Turn off the printer when performing these
installations. Disconnect the power cord when removing covers and guards for installing optional
equipment. Except for user-installable options, there are no parts that you can maintain or
service behind these covers.

The following are hazards to your safety:

e The power cord is damaged or frayed.

e Liquid is spilled into the printer.

e  The printer is exposed to water.

e The printer emits smoke, or the surface is unusually hot.

e The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.
3. Call an authorized service representative.

10 ColorQube 8700/8900 Color Multifunction Printer
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Power Cord

Use the power cord supplied with your printer.

Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check
the outlet.

Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a
ground connection terminal.

WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly.
Electrical products can be hazardous if misused.

Only use an extension cord or power strip designed to handle the electrical current capacity of the
printer.

Verify that the printer is plugged into an outlet that is providing the correct voltage and power.
Review the electrical specification of the printer with an electrician if necessary.

Do not place the printer in an area where people can step on the power cord.

Do not place objects on the power cord.

Do not plug or unplug the power cord while the power switch is in the On position.

If the power cord becomes frayed or worn, replace it.

To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet.

Telephone Line Cord

WARNING: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger
telecommunication line cord.

ColorQube 8700/8900 Color Multifunction Printer 11
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Operational Safety

Your printer and supplies were designed and tested to meet strict safety requirements. These include
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your
printer.

Ozone Release

This printer produces ozone during normal operation. The amount of ozone produced is dependent on
print volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone.
Install the printer in a well-ventilated room.

For more information in North America, go to:
e  ColorQube 8700 Color Multifunction Printer www.xerox.com/environment
e  ColorQube 8900 Color Multifunction Printer www.xerox.com/environment

In other markets, contact your local Xerox representative or go to:
e  ColorQube 8700 Color Multifunction Printer: www .xerox.com/environment_europe
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment_europe

Printer Location

e  Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight
of the printer. To find the weight for your printer configuration, see Physical Specifications on
page 230.

e Do not block or cover the slots or openings on the printer. These openings are provided for
ventilation and to prevent overheating of the printer.

e  Place the printer in an area where there is adequate space for operation and servicing.

e  Place the printer in a dust-free area.

e Do not store or operate the printer in an environment of extreme temperature or humidity.
e Do not place the printer near a heat source.

e Do not place the printer in direct sunlight.

e Do not place the printer where it is exposed directly to the cold air flow from an air conditioning
system.

e Do not place the printer in locations susceptible to vibrations.
e  For optimum performance, use the printer at the elevations specified in Elevation on page 232.
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Safety

Operational Guidelines

Do not remove the paper source tray that you selected in either the print driver or control panel
while the printer is printing.

Do not open the doors when the printer is printing.

Do not move the printer when it is printing.

Keep hands, hair, neckties, and so on away from the exit and feed rollers.

Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove
the protective covers.

Printer Supplies

Use the supplies designed for your printer. The use of unsuitable materials can cause poor
performance and a possible safety hazard.

Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.
Store all supplies in accordance with the instructions given on the package or container.

Keep all supplies away from the reach of children.

Never burn supplies.

When handling supplies, avoid skin or eye contact. Eye contact can cause irritation and
inflammation. Do not attempt to disassemble supplies, which can increase the risk of skin or eye
contact.
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Safety

Maintenance Safety

e Do not attempt any maintenance procedure that is not described in the documentation supplied
with your printer.

e Do not use aerosol cleaners. Clean with a dry lint-free cloth only.
e Do not burn any consumables or routine maintenance items.

For more information on the Xerox® supplies recycling program, go to:
e  ColorQube 8700 Color Multifunction Printer www.xerox.com/gwa
e  ColorQube 8900 Color Multifunction Printer www.xerox.com/gwa

See also:
Cleaning the Printer on page 161
Moving the Printer on page 182

14 ColorQube 8700/8900 Color Multifunction Printer
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8700&PgName=recyclesupplies&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8900&PgName=recyclesupplies&Language=English%20%20

Safety

Printer Symbols

Symbol Description

Warning or Caution:

Ignoring this warning could cause serious injury or even death.
Ignoring this caution could cause injury or damage to the property.

Oil from the cleaning kit can stain clothing and material. Do not tip the cleaning kit because

f oil can drip from the tray. Do not let the cleaning kit contact your clothing.

Do not tip the printer. It can cause ink to spill.

Do not touch the area of the printer marked with this symbol.

After turning it off, wait 30 minutes for the printer to cool before moving or tilting it.

Do not look into the scanner during operation.
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Safety

Environmental, Health, and Safety Contact
Information

For product safety information in the United States and Canada, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment.
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment

For product safety information in Europe, go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/environment_europe.
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/environment_europe.
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Features

This chapter includes:
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Features

Parts of the Printer

This section includes:

O LT FIONE VWi eeststststssesstestss s sas st ssss st s st s s e bbbt s e s s b e s b s s betn 18
e Left Front View of the ColorQube 8700XF Color Multifunction Printer ..........c.eeceeecerceeeerenrecre 19
®  RIGNE REAT VIBW ettt sas e s s sss st sss s s e a s bbb s s bbb s s b s s e s b s banen 20
®  CONLIOL PONEL ..ottt s s sss st s s s s bbb e b e e bbb s bbbt e s s b s s b s s snen 20
o Scanner With DOCUMENT FEEUEN ...ttt s sassass s s s s bbb sassansansans 22
®  550-SNEEE FINISNEN ...ttt bbb et e s bbb s bbb et sanen 22

Left Front View

10
11
12

13

14
—15

— 16
Ee

1. Tray 2 Left Side Door 10.Output Tray Paper Stop

2. Tray1 11.Ink Access Door

3. Top Left Side Door Release 12.0utput Tray

4, Top Left Side Door 13.Control Panel

5. Convenience Stapler 14.Front Door

6. Scanner with Document Feeder 15.Tray 2

7. Document Feeder Top Cover 16.Cleaning Unit

8. Document Feeder Tray 17.Waste Tray

9. Document Feeder Output Tray
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Features

Left Front View of the ColorQube 8700XF Color Multifunction Printer

9 10111213 14

1. 1800-Sheet High-Capacity Feeder 11.Output Tray

2. Left Side Doors 12.Output Tray Paper Stop
3. Tray 1 13.Ink Access Door

4. Top Left Side Door Release 14.650-Sheet Finisher

5. Top Left Side Door 15. Control Panel

6. Convenience Stapler 16.Front Door

7. Scanner with Document Feeder 17.Cleaning Unit

8. Document Feeder Top Cover 18.Waste Tray

9. Document Feeder Tray 19.Trays 2-5
10.Document Feeder Output Tray 20.Locking Wheels
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Features

Right Rear View

o> wN-=

Fax Line Connector 7. Finisher Interface

Feature Card Slot 8. Scanner Port

Ethernet Connection 9. Power Switch

USB Memory Port 10.Power Connector for Finisher
USB Port 11.Power Connector for Printer
Foreign Device Interface 12.Hard Drive Cover

Control Panel

The control panel consists of the touch screen, USB port, and buttons you press to control the functions
available on the printer. The control panel:

20

Displays the current operating status of the printer.
Provides access to copy, print, scan, and fax features.
Provides access to information pages.

Prompts you to load paper, replace supplies, and clear jams.
Displays errors and warnings.

Connects to a USB Flash drive for scan and print access.
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Features

18 17 1615
Machine Status displays printer status, settings, and information on the touch screen.
Job Status displays lists of the active, held, or completed jobs on the touch screen.

Services returns to the active service from the Job Status or Machine Status screens, or to a preset
service.

Services Home provides access to printer features, such as copy, scan, and fax.
Touch Screen displays information and provides access to printer functions.

Log In/Out provides access to password-protected features.

Help (?) displays information about the current selection or service.

Language changes the touch screen language and keyboard settings.

Ink Access Door Release turns on the release motor to open the ink access door.
Power Saver enters and exits low-power mode or the Quick Restart screen.

USB Memory Port provides USB Flash drive connection for use with Scan to USB and Print from
USB functions.

. Clear All clears previous and changed settings for the current selection. Press twice to reset all

features to their default settings, and clear existing scans.

. Stop temporarily stops the current job. Follow the onscreen instructions to cancel or resume your

job.
Start commences the selected job.
Interrupt Print pauses the currently printing job to run a more urgent job.

Alphanumeric Keypad allows you to enter copy quantities, fax numbers, and other numeric
information.

C (clear) deletes numeric values or the last digit entered using the alphanumeric keys.
Dial Pause inserts a pause in a telephone number when transmitting a fax.
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Scanner with Document Feeder

1. Document Feeder Top Cover 6. CVT Glass

2. Document Feeder Width Guides 7. Document Cover
3. Document Feeder Tray 8. Document Glass
4. Document Feeder Output Tray

5. Output Tray Paper Stop

650-Sheet Finisher

v —
Ll
e

Right Front View Left Rear View

1. Finisher Transport Left Door 3. Finisher Output Tray
2. Finisher Transport Cover Exit Cover

Finisher Top Cover
Staple Cartridge

Finisher Stapler Door

No v
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Features

Information Pages

Your printer has a printable set of information pages stored on its internal hard drive. Information pages
include configuration and font information, demonstration pages, and more.

1. At the printer control panel, press the Machine Status button.

2. On the Machine Information tab, touch Information Pages, then touch the desired information
page.
3. Touch Print.

Note: Information pages can also be printed from CentreWare Internet Services.

Printing the Configuration Report

1. Atthe printer control panel, press the Machine Status button.
2. On the Machine Information tab, touch Information Pages > Configuration Report > Print.
3. Touch Close after the report prints.
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Administration Features

This section includes:

®  ACCESSING The PrINTON ...ttt ettt st bbbt as st asbanen 24
®  CentreWare INTEINEL SEIVICES ...ttt sas st bbb bbb e s s esens 26
o Finding the IP AdAress Of the PrINLEN ...ttt ssssssss st sssssssssssssssssssassesssssssenses 26
®  AULOMALIC DALA COWOCIION vttt eee e ncens 27
o  Billing and UsAge INFOMMOALION ......vverceeierireeeeceesiesisssesestsssssssssssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnsses 27

For details, see the System Administrator Guide for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Accessing the Printer

The system administrator can set access rights on the printer to ensure that unauthorized users cannot
access the printer. If the system administrator configures authentication and authorization, users require
a login and password to access some or all of the features of the printer. The administrator can also
configure accounting to require an accounting code to access tracked features.

Authentication

Authentication is the process of confirming your identity. When the system administrator enables

authentication, the printer compares the information that you provide to another source of information,
such as an LDAP directory. The information can be a user name and password, or the information stored
on a magnetic or proximity ID card. If the information is valid, you are considered an authenticated user.

The system administrator can set permissions so that authentication is required when accessing features
at the control panel, in CentreWare Internet Services, or in the print driver.

If the administrator configures local or network authentication, you identify yourself by typing your user
name and password at the control panel or in CentreWare Internet Services. If the administrator
configures card reader authentication, you identify yourself by swiping a magnetic or proximity card at
the control panel and typing a passcode.

Note: The system administrator can allow you to type your user name and password when Smart
Card authentication is the primary authentication method. If the administrator configures an
alternative authentication method, and you misplace your card, you can still access the printer.
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Features

Authorization

Authorization is the function of specifying the features that you are allowed to access, and the process
of approving or disapproving your access. The system administrator can configure the printer to allow
you to access the printer, but restrict your access to certain features, tools, and services. For example, the
printer can allow you access to copying but restrict your access to color printing. The system
administrator can also control your access to features at specific times during the day. For example, the
system administrator can restrict a group of users from printing during peak business hours. If you
attempt to print using a restricted method or during a restricted time, the job does not print. Instead, the
printer prints an error page and the job appears with an error message in the Job Status lists.

Where the system administrator stores the authorization information determines the authorization type.
e Local authorization stores the login information on the printer in the user Information Database.

e  Network authorization stores the login information in an external database, such as an LDAP
directory.

The system administrator sets authorization permissions. To set or edit user permissions for access to
printer features, you must log in as the administrator.

Accounting

Accounting monitors the print, copy, scan, and fax impressions produced and who produces them.
Accounting associates your user name and account identification information with each document you
print. Accounting data is collected and stored as jobs are submitted to the printer.

The system administrator must create user accounts and enable the accounting feature. When
accounting is enabled, you must log in to the printer before accessing services. You must also provide
your account details in the print driver before printing documents from a computer. The system
administrator can set limits to restrict the total number of jobs by type that a user can produce. The
administrator can also generate reports listing usage data for individual users and groups.

For details, see the System Administrator Guide for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Logging In

Logging in is the process by which you identify yourself to the printer for authentication. If
authentication is set, to access printer features, you log in with your user credentials.

Logging In at the Control Panel
1. Atthe control panel, either press Log In/Out or touch Guest.

2. If an administrator has configured more than one authentication server, select your domain, realm,
or tree.

a. Touch Domain, Realm, or Tree.
b. From the list, touch your domain, realm, or tree.
c. Touch Save.

3. Type your user name, then touch Next.

4. Type your password, then touch Done.
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Features

Logging In to CentreWare Internet Services
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on
page 26.

At the top of the page, next to the lock and key icon, click Login.
Type the User ID in the space provided.

Type the password in the space provided.

Click Login.

it wN

Administrator Password

The administrator password is required when accessing locked settings in CentreWare Internet Services
or at the control panel. Most printer models have a default configuration that restricts access to some
settings. Access is restricted for settings on the Properties tab in CentreWare Internet Services, and
settings on the Tools tab on the control panel touch screen.

Logging In as the System Administrator at the Control Panel

1. Atthe control panel, press Log In/Out.

2. Type admin, then touch Next.

3. Type your password, then touch Done.

Note: The system administrator user name is admin and the default password is 1111.

CentreWare Internet Services

CentreWare Internet Services is the administration and configuration software installed on the
embedded Web server in the printer. It allows you to configure and administer the printer from a Web
browser.

CentreWare Internet Services requires:

e A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux
environments.

e  TCP/IP and HTTP enabled in the printer.
e A network-connected computer with a Web browser that supports JavaScript.

For details, see the Help in CentreWare Internet Services or the System Administrator Guide.

Accessing CentreWare Internet Services

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press
Enter or Return.

Finding the IP Address of the Printer

You can view the IP address of your printer on the control panel or on the Configuration Report.
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Finding the IP Address at the Control Panel

If Display Network Settings is set to Show IPv4 Address, the address appears in the top left corner of the
touch screen display. To display the IPv4 Address on the control panel, do one of the following:

e To configure Display Network Settings using CentreWare Internet Services, click Properties >
Security > Display Network Settings > Show IPv4 Address > Apply. For details, see the Help in
CentreWare Internet Services.

e To configure Display Network Settings at the control panel, press the Machine Status button.
Touch Tools > Network Settings > Display Network Settings > Show IPv4 Address > OK.

To view the IP address of the printer in the control panel menu:
1. At the printer control panel, press the Machine Status button.
2. Record the IP addresses from the IPv4 and IPv6 areas on the display.

Note: If the IPv4 or IPv6 addresses are not configured, they do not appear in the display.

Finding the IP Address on the Configuration Report

1. Atthe printer control panel, press the Machine Status button.

2. On the Machine Information tab, touch Information Pages > Configuration Report > Print.
3. Touch Close.
4

IPv4 and IPv6 address information is located in the Connectivity Protocols section of the
Configuration Report under TCP/IPv4 and TCP/IPv6.

Automatic Data Collection

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a
designated servicer uses this data to support and service the printer, or for billing, supplies
replenishment, or product improvement. Automatically transmitted data can include product
registration, meter read, supply level, printer configuration and settings, software version, and problem
or fault code data. Xerox cannot read, view, or download the content of your documents residing on or
passing through your printer or any of your information management systems.

To turn off automatic data collection:
On the Welcome page in CentreWare Internet Services, click the link in the note regarding automated
services.

Billing and Usage Information

Billing and printer usage information appears on the Billing Information screen. The impression counts
shown are used for billing.

For details, see Billing and Usage Information on page 178.
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More Information

Resource Location

Installation Guide Packaged with the printer.

Other documentation for your printer e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/CQ8700docs

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900docs

Recommended Media List United States:

e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/paper

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/paper

European Union:

e ColorQube 8700 Color Multifunction Printer:
WWW.Xerox.com/europaper

e ColorQube 8900 Color Multifunction Printer:
WWw.Xerox.com/europaper

Technical support information for your printer; e ColorQube 8700 Color Multifunction Printer:
including online technical support, Online Support www.xerox.com/office/CQ8700support

Assistant, and driver downloads. e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900support

Information about menus or error messages Press the control panel Help (?) button.

Information Pages Print from the control panel, or from CentreWare Internet
Services, click Status > Information Pages

CentreWare Internet Services documentation In CentreWare Internet Services, click Help.

Order supplies for your printer e ColorQube 8700 Color Multifunction Printer:

www.xerox.com/office/CQ8700supplies

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/CQ8900supplies

A resource for tools and information, including www.xerox.com/office/businessresourcecenter
interactive tutorials, printing templates, helpful
tips, and customized features to meet your
individual needs.

Local sales and support center e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/worldcontacts

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/worldcontacts

Printer registration e ColorQube 8700 Color Multifunction Printer:
www.xerox.com/office/register

e ColorQube 8900 Color Multifunction Printer:
www.xerox.com/office/register

® ~N: . .
Xerox~ Direct online store www.direct.xerox.com/
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Xerox® Welcome Center

If you need assistance during or after printer installation, visit the Xerox® website for online solutions
and support for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/worldcontacts
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/worldcontacts

If you require further assistance, contact the Xerox® Welcome Center for the United States and Canada
at 1-800-835-6100.

If a local Xerox representative telephone number was provided during printer installation, record the
telephone number in the following space.

#

If you need additional help using your printer:

1. Refer to this user guide.

2. Contact the system administrator.

3. Visit our customer website for your printer model:
—  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700support
—  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900support

To assist you, the Welcome Center needs the following information:
e The nature of the problem.

e  The serial number of the printer.

e The fault code.

e The name and location of your company.

Locating the Serial Number
To contact Xerox for assistance, you need the printer serial number. The serial number is on the left side

of the printer frame behind Tray 2. The serial number also appears on the control panel. Press the
Machine Status button to view the serial number on the control panel.

ColorQube 8700/8900 Color Multifunction Printer 29
User Guide


http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8700&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8900&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=ColorQube+CQ8700&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=ColorQube+CQ8900&PgName=tech&Language=English




Installation and Setup

This chapter includes:

o INStallation ANA SETUDP OVEIVIEW ...t sssssesisssess st ssssssssssssssssssssssssssssssssssssssssssssssssssssssssssasssses
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®  INSLALING thE SOFLWAIE ...t sssss s e s s s s s enses
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See also:

The System Administrator Guide for your printer model:
ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

The Installation Guide is packaged with your printer.
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Installation and Setup Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure
the initial settings of the printer, then install the driver software and utilities on your computer.

You can connect to your printer directly from your computer using USB, or connect over a network using
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet
connection because it is typically faster than a USB connection, and it provides access to CentreWare
Internet Services. It also provides access to email, workflow scanning, and server fax services.

If the Software and Documentation disc is not available, you can download the latest drivers for your
printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers

Physically Connecting the Printer to the Network

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is
used for one or more computers and supports many printers and systems simultaneously. An Ethernet
connection provides direct access to printer settings using CentreWare Internet Services.

To connect the printer:
1. Connect the power cord to the printer, and plug the cord into an electrical outlet.

2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer.
Connect the other end of the Ethernet cable to a correctly configured network port on a hub or
router.

3. Turn on the printer.

Note: For details, see the System Administrator Guide for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Connecting to a Telephone Line

1. Ensure that the printer is turned off.

2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on
the back of the printer.

3. Connect the other end of the RJ11 cable to an operating telephone line.
4. Enable and configure the Fax functions.

For details, see Selecting Fax Options on page 136, Selecting Server Fax Options on page 145, or
Selecting Internet Fax Options on page 150.
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Turning On the Printer

The power switch is on the back of the printer above the power cord. Ensure that all of the other cables
are connected, then turn on the printer.

Initial Printer Setup

Ensure that the printer is set up before installing the printer software. Setup includes enabling the
optional features and assigning an IP address for the Ethernet network connection. If the printer has not
been turned on and configured previously, see the System Administrator Guide for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs
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Modifying General Settings

You can modify printer settings such as the language, date and time, units of measurement, display
brightness, and startup page from the control panel.

1. Atthe printer control panel, press the Machine Status button, then touch the Tools tab.
2. Touch Device Settings > General, then touch the setting you want to change:

—  Manual Wake-up Setting allows you to turn the Wake-up Sensor on or off. It also allows you to
set the sensitivity to wake the printer. When the sensitivity is high, you can wake the printer by
pressing any button or touching the screen. When the sensitivity is low, you can wake the
printer only by pressing Power Saver.

—  Energy Saver specifies when the printer goes into energy-saving mode.
— Date/Time allows you to set the time zone, date, time, and display format.

Note: The date and time are set automatically through Network Time Protocol (NTP). To modify
these settings, go to the Properties tab in CentreWare Internet Services and change the Date and
Time Setup to Manual (NTP Disabled).

— Language/Keyboard allows you to set the language and keyboard layout.

—  Custom Keyboard Button allows you to assign text to the custom key on the virtual keyboard.
3. Change settings as needed, then touch Save.
4. Toreturn to the main screen, touch Home.
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Setting Energy Saver Mode

You can set the time the printer spends idle in ready mode before the printer transitions to a lower

power level.

1. Atthe printer control panel, press the Machine Status button, then touch the Tools tab.

2. Touch Device Settings > General > Energy Saver.

3. Touch an option:
— Intelligent Ready causes the printer to wake and sleep based on previous usage patterns.
— Job Activated causes the printer to wake when it detects activity.
Note: Energy Saver Timers allows you to specify the time-out values for low power and sleep states.
—  Scheduled causes the printer to wake and sleep according to a schedule you specify.
If you selected Intelligent Ready or Job Activated, under Fast Resume, touch On to reduce the wake
time. This option changes the default sleep and low-power timeout periods, and increases energy
usage.
If you selected Scheduled as the Energy Saver Mode, to select the times at which you want the
printer to wake or sleep, touch Scheduled Settings.
a. Touch aday of the week in the list.
b. To wake on activity, under Schedule Based On, touch Activity.
¢. Towake the printer at a certain time, touch Time > Wake Up Time, then select the time for the

printer to wake up.
d. To set the printer to sleep at a certain time, touch Time > Energy Saver Time, then select the
time for the printer to sleep.
4. Touch OK.

Setting the Date and Time at the Control Panel

1.
2.

At the printer control panel, press the Machine Status button, then touch the Tools tab.
Touch Device Settings > General > Date and Time.

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as
the System Administrator at the Control Panel on page 26.

To set the time zone, touch Time Zone, then select the time zone from the drop-down list.

Note: The date and time are set automatically through Network Time Protocol (NTP). To modify
these settings, go to the Properties tab in CentreWare Internet Services and change the Date and
Time Setup to Manual (NTP Disabled).

To set the date, touch Date, select a format, then set the date.

To set the time, touch Time, then use the keypad to enter the time. To use 24 hour format, select
Display 24 hour clock.

Click Save.
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Installing the Software

This section includes:

o Operating SYsterm REQUITEMENTS ........covrieeireeeresiesieseissessss s sssssssssssssssssssssssssssssssssssssssssssssssasssssssssssssssssssssssssses 36
o Installing Drivers and ULilitieS fFOr WINAOWS ..........coovriereerreinrersessisssiesissssssisssssesssssssssssssssssssssssssssssssssssesses 36
e Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later .........cooooeeeereoneereereceecens 37
e Installing Drivers and Utilities for UNIX anNd LINUX......c..cooeuerienrnernsisinsinssnsisssessessissesssssssssssssssssssssssssssnses 38
O OLNEI DIIVETS ..ottt s s es s b st s bR s b e b s s 39

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and
has a valid IP address. The IP address usually appears in the upper left corner of the control panel.

If the Software and Documentation disc is not available, you can download the latest drivers for your
printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers

Operating System Requirements

e  Windows XP SP3 and later; Windows Server 2003 and later
e  Macintosh OS X version 10.5 and later
e Novell Netware 5.0 and later

e UNIX and Linux: Your printer supports connection to various UNIX platforms through the network
interface.

Installing Drivers and Utilities for Windows
To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:

1. Insert the Software and Documentation disc into the appropriate drive on your computer. The
installer starts automatically.

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe
installer file.

To change the language, click Language.

Select your language, then click OK.

Click Install Drivers > Install Print and Scan Drivers.

To accept the license agreement, click I Agree.

From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers, click Extended Search.

No v WwWN
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8. If your printer still does not appear in the list of discovered printers, and you know the IP address:
a. Click the Network Printer icon at the top of the window.
b. Enter the IP address or the DNS name of the printer.
c. Click Search.
d. From the list of discovered printers, select your printer, then click Next.

9. If the printer still does not appear in the list of discovered printers, and you do not know the IP
address:

a. Click Advanced Search.

b. If you know the gateway address and subnet mask, click the top button and enter the
addresses into the Gateway and Subnet Mask fields.

c. If you know the address of another printer on the same subnet, click the middle button and
enter the address in the IP Address field.

d. Click Search.
e. From the list of discovered printers, select your printer, then click Next.

Note: When the printer appears in the Discovered Printers window, it displays the IP address. Record
the IP address for future use.

10. Select the desired driver.
11. Click Install.
If the installer prompts you for the IP address, enter the IP address of the printer.

If the installer prompts you to restart your computer, click Restart to complete the installation of
the drivers.

12. To complete the installation, click Finish.

Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver.

To install the print and scan driver software:
1. Insert the Software and Documentation disc into the appropriate drive on your computer.
2. Open the Mac folder, then open the Mac OS 10.5+Universal PS folder.

3. Open Xerox® ColorQube 8700 CD.dmg or Xerox® ColorQube 8900 CD.dmg as needed for your
printer.

To run ColorQube 8700 CD.pkg or ColorQube 8900 CD.pkg, double-click the appropriate file name.
When prompted, click Continue.
To accept the license agreement, click I Agree.

No wv-Ee

To accept the current installation location, click Install, or select another location for the installation
files, then click Install.

®

Enter your password, then click OK.

9. From the list of discovered printers, select your printer, then click Next.

If your printer does not appear in the list of discovered printers:

a. Click the Network Printer Icon.

b. Type the IP address of your printer, then click Continue.

c.  Select your printer in the list of discovered printers, then click Continue.
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10.
11.
12.

To accept the print queue message, click OK.
Select or clear the Set Printer as Default and Print a Test Page check boxes.
Click Continue, then click Close.

Note: The printer is automatically added to the printer queue in Macintosh OS X version 10.5 and
later.

To verify the installation of printer options with the print driver:

1.

vt wN

From the Apple menu, click System Preferences > Print.

Select the printer in the list, then click Options and Supplies.

Click Driver, then confirm that your printer is selected.

Confirm that all of the options installed on the printer appear correct.

If you change settings, click Apply Changes, close the window, and quit System Preferences.

Installing Drivers and Utilities for UNIX and Linux

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a
Xerox® Services for UNIX Systems code package and a printer support package. The Xerox® Services for
UNIX Systems code package must be installed before installing the printer support package.

38

Note: You must have root or superuser privileges to perform the UNIX print driver installation on
your computer.

At the printer, do the following:
a. Verify that both the TCP/IP protocol and the proper connector are enabled.
b.  On the printer control panel, for the IP address, do one of the following:

e Allow the printer to set up a DHCP address.

e Enter the IP address manually.

¢.  Print the Configuration Report and keep it for reference. For details, see Configuration Report
on page 23.

At your computer, do the following:

a. Go to www.xerox.com/office/CQ8700drivers or www.xerox.com/office/CQ8900drivers as
appropriate, and select your printer model.

b. From the Operating System menu, select UNIX, then click Go.

Select the Xerox® Services for UNIX Systems package for the correct operating system. Install
this package before installing the printer support package.

To begin downloading, click the Start button.

Repeat steps a and b, then click the printer support package for use with the Xerox® Services for
UNIX Systems package that you selected earlier.

f.  To begin downloading, click the Start button.
g. Inthe notes below the driver package that you selected, click the Installation Guide link, then
follow the installation instructions.

Note: To load Linux print drivers, perform the preceding procedures but select Linux as the operating
system. Select Xerox® Services for Linux Systems driver or the Linux CUPS Printing Package. You
can also use the CUPS driver included in the Linux package.
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Supported Linux drivers are available for download for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers

For details about UNIX and Linux drivers, see the System Administrator Guide for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

Other Drivers

The Xerox® Global Print Driver works with any printer on your network, including printers made by other
manufacturers. It configures itself for your printer upon installation.

The Xerox® Mobile Express Driver works with any printer available to your computer that supports
standard PostScript. It configures itself for the printer you select every time you print. If you travel
frequently to the same sites, you can save your favorite printers in that location and the print driver
saves your settings.

These drivers are available for download for your printer model:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700drivers
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900drivers
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Managing Jobs

Managing Jobs at the Control Panel

From the control panel Job Status, you can view lists of active jobs, secure jobs, or completed jobs. You
can delete, print, or view job progress or job details for a selected job.

From the Print From menu, you can view lists of saved jobs, jobs stored on a USB Flash drive, or jobs
stored in printer folders. You can select and print jobs from any of the lists.

See also:

Held Print Jobs on page 82
Secure Print on page 78
Saved Job on page 80
Sample Set on page 79
Delay Print on page 80
Print From on page 82

Managing Jobs in CentreWare Internet Services

You can view a list of active jobs and delete print jobs from the Active Jobs list in CentreWare Internet
Services. You can also print, copy, move, or delete saved jobs. For details, see the Help in CentreWare
Internet Services.

Managing Held Print Jobs

If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is held
until you release it. To view held jobs, touch the Held Print Jobs or My Held Print Jobs tabs.

Unidentified jobs are jobs that are not associated with a user name. Unidentified jobs originate from a
computer that does not require a user to log in. Examples are a job sent from a DOS or UNIX window
using LPR, Port 9100, or from the Jobs tab in CentreWare Internet Services.

e Toseeallist of the unidentified jobs, touch the Unidentified Print Jobs tab.

e Torelease a held job, touch the job, then touch Release. To release all held jobs, touch Release All
Jobs.

Managing Secure Print Jobs

When you send a secure print job, the job is held until you release it by typing a passcode at the control
panel. To view a list of secure print jobs, press the Job Status button, then touch Secure Print Jobs. For
details, see Secure Print on page 78.

Note: Only the user that sent the job or the system administrator can delete a secure print job.
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This chapter includes:

Supported Paper..............
Loading Paper ....................
Printing on Special Paper
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Supported Paper

This section includes:

®  RECOMMENAEA MEAIA c..reereeeeeeeeee et cs e ssse e ae e es et e nessreens 42
©  OFAEIING PAPET ..ottt ssssss st ssssssss s ssss st s sass s s s s s s st s s sas e ses s ssassssssesasesnsssesaens 42
o Generdl Paper LoAdiNG GUIAEIINES ........ovreeriereeresieiessssesssstss s ssss s ssssssssssssssssssssssssssssssssssssssssssssssssssssnsssnses 43
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e Supported Paper Types and Weights for Automatic 2-Sided Printing........c.ccoeeeeveenreonsennrnneesnneenneseceenens 45
o  Supported Paper Sizes for Automatic 2-Sided Printing ........cocceernernsiesissnssnsiesessesssssssssssssessssssssssssssnses 46
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Your printer is designed to use various paper and other media types. To ensure the best print quality and
to avoid jams, follow the guidelines in this section.

For best results, use Xerox paper and media recommended for your printer.

Recommended Media
A list of paper and media recommended for your printer is available at:

North America
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/paper
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/paper

European Union
o  ColorQube 8700 Color Multifunction Printer: www.xerox.com/europaper
o  ColorQube 8900 Color Multifunction Printer: www.xerox.com/europaper

See also:
Paper Tips Page, for details, see Information Pages on page 23.

Ordering Paper

Order supplies from your local reseller or go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700supplies
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900supplies

42 ColorQube 8700/8900 Color Multifunction Printer
User Guide


http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8700&PgName=rmleu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8900&PgName=rmleu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8700&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=ColorQube+CQ8900&PgName=order&Language=English

Paper and Media

General Paper Loading Guidelines

e Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray.

e  Adjust the paper guides to fit the paper size.

e Fan paper before loading it in the paper tray.

e If excessive jams occur, use paper or other approved media from a new package.

e Use only recommended Xerox® transparencies. Print quality could vary with other transparencies.
e Do not print on label media once a label has been removed from a sheet.

e Use only paper envelopes. Print envelopes 1-sided only.

Paper That Can Damage Your Printer

Some paper and other media types can cause poor output quality, increased paper jams, or damage
your printer. Do not use the following:

e  Rough or porous paper

e Inkjet paper

e Non-laser glossy or coated paper

e Paper that has been photocopied

e  Paper that has been folded or wrinkled
e  Paper with cutouts or perforations

e Stapled paper

e Envelopes with windows, metal clasps, side seams, or adhesives with release strips
e Padded envelopes

e Plastic media

e Iron on transfer paper

& CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or special media. The Xerox® Total
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside
these areas. Contact your Xerox representative for details.

Paper Storage Guidelines

Storing your paper and other media properly contributes to optimum print quality.

e  Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from
ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly
damaging to paper.

e  Reduce the exposure of paper to strong lights for long periods of time.

e  Maintain constant temperatures and relative humidity.

e Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect
moisture.

e  Store paper flat, either on pallets, cartons, shelves, or in cabinets.
e Avoid food or drinks in the area where paper is stored or handled.
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e Do not open sealed packages of paper until you are ready to load them into the printer. Leave
stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or
gain.

e Some special media is packaged inside resealable plastic bags. Store the media inside the bag until
you are ready to use it. Keep unused media in the bag and reseal it for protection.

Supported Paper Types and Weights

Tray Types and Weights

Tray 1 Plain (67-122 g/m?)

Hole Punched (67-122 g/m?)
Transparency

Letterhead (67-122 g/m?)
Lightweight Cardstock (123-199 g/m?)
Cardstock (200-220 g/m?)
Recycled (67-122 g/m?)
Labels

Pre-Printed (67-122 g/m?)
Lightweight (60-66 g/m?)
Custom

525-Sheet Feeder (Trays 2-5) Plain (67-122 g/m?)

Hole Punched (67-122 g/m?)
Letterhead (67-122 g/m?)
Lightweight Cardstock (123-199 g/m?)
Cardstock (200-220 g/m?)
Recycled (67-122 g/m?)
Labels

Pre-Printed (67-122 g/m?)
Lightweight (60-66 g/m?)
1800-Sheet High-Capacity Feeder Plain (67-122 g/m?)

Hole Punched (67-122 g/m?)
Letterhead (67-122 g/m?)
Recycled (67-122 g/m?)
Pre-Printed (67-122 g/m?)
Lightweight (60-66 g/m?)
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Supported Standard Paper Sizes

European Standard Sizes North American Standard Sizes
Tray 1 A4 (210 x 297 mm,8.3 x 11.7 in.) Letter (216 x 279 mm,8.5 x 11in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.) Legal (216 x 356 mm, 8.5 x 14in.)

A6 (105 x 148 mm, 4.1 x 5.8 in.) 76 x127 mm, 3x5in.

B5(176 x 250 mm, 6.9 x 9.8 in.) Executive (184 x 267 mm,

JISB5 (182 x 257 mm,7.2 x 10.1 in) |7-25 x 10.5in.)
Statement (140 x 216 mm, 5.5 x 8.5

in.)

216 x330 mm, 8.5x13in.
525-Sheet Feeder (Trays A4 (210 x 297 mm,8.3 x 11.7 in.) Letter (216 x 279 mm,8.5 x 11in.)
2-5) A5 (148 x 210 mm, 5.8 x 8.3 in.) Legal (216 x 356 mm,8.5 x 14in.)

B5(176 x 250 mm, 6.9 x 9.8 in.) Executive (184 x 267 mm,

JISB5(182 x 257 mm, 7.2 x 10.1 in.) |7-25 x 10.5in.)
Statement (140 x 216 mm, 5.5 x 8.5

in.)

216 x330 mm, 8.5x13in.
1800-Sheet High-Capacity |A4(210 x 297 mm,8.3 x 11.7 in.) Letter (216 x 279 mm, 8.5 x 11in.)
Feeder Legal (216 x 356 mm, 85 x 14in.)

Supported Paper Types and Weights for Automatic 2-Sided Printing

Paper Types Weights

Plain 67-122 g/m?
Hole Punched 67-122 g/m?
Letterhead 67-122 g/m?
Recycled 67-122 g/m?
Pre-Printed 67-122 g/m?
Lightweight 60-66 g/m?

Notes:The printer does not support the following paper for automatic 2-sided printing:

e Reloaded, which is paper previously printed or copied on laser or solid ink printers.
e Envelope

e  Glossy Cardstock

e  Paper heavier than 122 g/m?
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Supported Paper Sizes for Automatic 2-Sided Printing

European Standard Sizes North American Standard Sizes
A4 (210 x 297 mm,8.3 x 11.7 in.) Letter (216 x 279 mm, 8.5 x 11in.)
A5 (148 x 210 mm, 8.3 x 5.8 in.) Legal (216 x 356 mm, 8.5 x 14in.)
JISB5(182 x 257 mm,7.2 x 10.1 in.) Executive (184 x 267 mm,7.25 x 10.5in.)
B5(176 x 250 mm,6.9 x 9.8 in.) 216 x330 mm, 8.5x13in.

Statement (140 x 216 mm, 5.5 x 8.5in.)

In addition to the standard sizes, you can use the following custom-size paper for automatic 2-sided
printing:

e  Minimum size 139.7 x 210 mm (5.5 x 8.3 in.)

e  Maximum size 216 x 356 mm (8.5 x 14 in.)

Supported Custom Paper Sizes

Paper Sizes

Tray 1 Minimum: 76 x 127 mm, 3 x 5in.
Maximum: 216 x 356 mm, 8.5 x 14 in.

Note: Print custom-size paper from Tray 1 only.

Supported Envelope Sizes

Tray Envelope Sizes

Tray 1 DL envelope (110 x 220 mm, 4.33 x 8.66 in.)
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)
C5 envelope (162 x 229 mm, 6.4 x 9 in)

No. 5%2 envelope (111 x 146 mm, 4.4 x 5.75in.)
Envelope 6 x 9 (152 x 228 mm,6x9 in.)

No. 6% envelope (92 x 165 mm, 3.6 x 6.5 in.)

A7 envelope (133 x 184 mm,5.25 x 7.25 in)
Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.)
Choukei 3 envelope (120 x 235 mm, 4.72 x 9.25in.)
Choukei 4 envelope (90 x 205 mm, 3.54 x 8.07 in.)
525-Sheet Feeder (Trays 2-5) DL envelope (110 x 220 mm, 4.33 x 8.66 in.)
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.)
C5 envelope (162 x 229 mm, 6.4 x 9 in.)
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Loading Paper

This section includes:

®  LOAAING PAPET IN TIAY Tttt sssesssass s ssss st ssssssssss s ssssssssssssassssssssssssssssssssssssssssssssnsssssassnssssssnsen 47
o Loading Paper in A 525-Sheet FEEUET ...t sssesss s ssssss st s ssssssssssssenens 49
e  Configuring the 1800-Sheet High-Capa ity FEEUEN ...t isssessssssssssssesssassesssasssenses 51
e Loading Paper in the 1800-Sheet High-Capa ity FEEAEN ... sessssssasssanees 54

Loading Paper in Tray 1

Tray 1 supports the widest variety of paper types. It is intended for small quantity jobs and jobs using
special media. The tray extension provides support for larger paper.

1. Open Tray 1 by rotating it outward.

] —
f
| = D
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2. we
3. \
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4. Insert the paper with the short edge first.

Notes:

e Load the printed sheet into the tray with the printed side face down.
e Load hole punched paper with the holes toward the back.
e Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.

5. Adjust the width guides until they touch the edges of the paper.

!

6. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
7. On the printer touch screen, touch Confirm.
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Loading Paper in a 525-Sheet Feeder
1. Pull out the tray until it stops.

2.  Move the length and width guides out:
a. Pinch the guide lever on each guide.
b. Slide the guides outward until they stop.
C. Release the levers.

3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.
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4. Load the paper with the short edge against the left side of the tray.

Notes:

e Load paper into the tray with the print side face up.
e Load hole punched paper with the holes toward the back.
e Do not load paper above the maximum fill line. Overfilling can cause paper jams.

/

5. Adjust the paper guides in the tray to match the size of the paper.

rEN
@\/

6. Close the tray. A message appears on the control panel.
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7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.
8. On the printer touch screen, touch Confirm.

Configuring the 1800-Sheet High-Capacity Feeder

The 1800-Sheet High-Capacity Feeder is a dedicated paper tray. It must be configured to support the
paper in use. If the tray has not been used, it must be configured for the desired paper size. If you are
changing the paper size, you must reconfigure the tray for the new paper size. For details on supported
paper sizes, see Supported Paper on page 42.

Before changing the drawer configuration, always compare the paper size to the configuration of the
1800-Sheet High-Capacity Feeder. If the paper size matches, no adjustment is needed.

1. Pull out the tray until it stops.
2.  Remove the paper from the paper tray.
3. Move the paper length guide to the selected paper size.

a. Toremove the paper length guide, pinch the tab at the top of the guide and lift it out of the
tray.
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b. Align the tabs at the top and bottom of the guide with the corresponding slots at the top and
in the bottom of the tray.

LGL

c. Lower the tabs at the bottom of the guide into the slots in the bottom of the tray. Click the top
tab into the slot at the top of the tray to lock it.

Note: Do not force the guide into place. If properly aligned, the top tab locks into the slot with light
pressure.

4. Move the front paper width guide to the selected paper size.
a. Toremove the guide, pinch the tabs at each end of the guide plate, then lift it from the tray.
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b. Align the tabs at the top and bottom of the guide with the corresponding slots at the top and
in the bottom of the tray.

/4 A

LTR
LGL

Note: To allow the plate to drop into place when aligning the front guide plate, the middle tab must
be aligned properly.

c. Lower the tabs at the bottom of the guide into the slots at the bottom of the tray. Click the top
tab into the slot at the top of the tray to lock it.

5. To move the rear paper width guide to the selected paper size, follow steps 4a-—c.

P
1 LTR
AL — = LGL
LTR
LGL
: I
1
A4
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Loading Paper in the 1800-Sheet High-Capacity Feeder

Note: Do not use glossy paper or labels in the 1800-Sheet High-Capacity Feeder.

1. Pull out the tray until it stops.

2. Fan the edges of the paper before loading it into the paper trays. This procedure separates any
sheets of paper that are stuck together and reduces the possibility of paper jams.

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary.

3. Load the paper with the short edge against the left side of the tray.

Notes:

e Load paper into the tray with the print side face down.
e Load hole punched paper with the holes toward the back.
e Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam.
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Close the tray.
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Printing on Special Paper

This section includes:

O ENVEIOPES ..ottt b st bbb RS AR b e A bR e bt a st 56
O LODIIS ettt ARttt s bbb A e b s e anaes 61
©  TTONSPAMENCIES ..ot ssasss s essssssssssssssssss s sssssssssssssssssssasssssssssssssssssssssesssssassssssssanssnsassassansssssnssnssnssssssnnens 63

A list of paper and media recommended for your printer is available at:

North America
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/paper
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/paper

European Union
o  ColorQube 8700 Color Multifunction Printer: www.xerox.com/europaper
o  ColorQube 8900 Color Multifunction Printer: www.xerox.com/europaper

See also:
Paper Tips Page, for details, see Information Pages on page 23.

Order supplies from your local reseller or go to:
e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700supplies
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900supplies

i\ CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does
not cover damage caused by using unsupported paper or special media. The Xerox® Total
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside
these areas. Contact your Xerox representative for details.

Envelopes

Print envelopes only from Tray 1 or from a 525-Sheet Feeder. For details, see Supported Envelope Sizes
on page 46.

Guidelines for Printing Envelopes

e  Print quality depends on the quality and construction of the envelopes. Try another envelope brand
if you do not get desired results.

e  Maintain constant temperatures and relative humidity.

e  Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect
print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or
during printing.

e  Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book
on top of them.
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e Inthe print driver software, select Envelope as the paper type.

¢ Do not use padded envelopes. Use envelopes that lie flat on a surface.

e Do not use envelopes with heat activated glue.

e Do not use envelopes with press and seal flaps.

e Do not use envelopes with windows, metal clasps, side seams, or adhesives with release strips.
e Use envelopes with diagonal seams, not side seams.

B

Loading Envelopes in Tray 1

1. Open Tray 1 by rotating it outward.
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3. Insert up to 10 envelopes in the tray, align the stack, then adjust the guides until they are touching
the edges of the stack.

—  Load side flap envelopes with the flaps closed, flaps up, and flaps toward the front of the
printer.

— Load end flap envelopes with the flaps closed, flaps up, and flaps on the leading edge, going
into the printer.

4. At the control panel, select the envelope size from the paper size list.
5. Verify that type is set to Envelope, then touch Confirm.
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Loading Envelopes in a 525-Sheet Feeder
1. Pull out the tray until it stops.

2.  Move the length and width guides out:
a. Pinch the guide lever on each guide.
b. Slide the guides outward until they stop.
c. Release the levers.
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3. Load the envelopes into the tray, align the stack, then adjust the guides to touch the edges of the
envelopes.

— Load side flap envelopes with the flaps closed, flaps down, and flaps toward the front of the
tray.

— Load end flap envelopes with the flaps closed, flaps down, and flaps at the left side of the tray.

Note: Do not load envelopes above the bottom fill line. Overfilling the tray can cause the printer to
jam.

4.  Close the tray.

1  —

5. Verify the size, type, and color settings. Change the selection for any incorrect setting.
6. On the printer touch screen, touch Confirm.
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Labels

Print labels from Tray 1 or from a 525-Sheet Feeder.

Guidelines for Printing Labels

Use labels designed for laser printing.
Print only on one side of the sheet of labels.
Use full sheet labels only.

Store unused labels flat in their original packaging. Leave the sheets of labels inside the original
packaging until ready to use. Return any unused sheets of labels to the original packaging and
reseal it.

Do not store labels in conditions of extreme heat or humidity. Storing them in extreme conditions
can cause print-quality problems or cause them to jam in the printer.

Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and
jam in the printer.

Do not use vinyl labels.
Do not feed a sheet of labels through the printer more than once.
Do not use dry gum labels.

CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing
sheet. It could damage the printer.

Loading Labels in Tray 1

1.
2.

Remove all paper from the tray.
Load labels face down with the top of the sheet feeding into the printer.
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3. Adjust the width guides until they touch the edges of the paper.

4. On the control panel, change the type to Label.
5. Verify the size, type, and color settings. Change the selection for any incorrect setting.
6. On the printer touch screen, touch Confirm.

7. Inthe Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type
setting.

Loading Labels in a 525-Sheet Feeder

1. Remove all paper from the tray.
2. Load labels face up with the top of the sheet against the left side of the tray.

3. Adjust the width guides until they touch the edges of the paper.
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5.
6.
7.

8.

Paper and Media

Close the tray.

On the control panel, change the type to Label.
Verify the size, type, and color settings. Change the selection for any incorrect setting.
On the printer touch screen, touch Confirm.

| Ll Ll 5|

In the Printing Preferences of the print driver, on the Paper/Output tab, change the Paper Type
setting.

Transparencies

Use only Tray 1 for printing transparencies.

Guidelines for Printing Transparencies

Remove all paper before loading transparencies in the tray.

Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print
quality.

After loading transparencies, change the paper type to Transparency on the printer control panel.
In the print driver software, select Transparency as the paper type.

Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam.

Do not use transparencies with stripes on the side.

Do not fan transparencies.
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This chapter includes:

®  PrINTING OVEIVIEW ..ottt ca e e s sees s e bbb e s st sseeas 66
o Selecting PriNtiNG OPLIONS ... sisssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssassssssas 67
®  PrINTING FEATUIES ...ttt sttt s sss bbb s b s s s asesaees 71
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Printing Overview

Before printing, your computer and the printer must be plugged in, turned on, and connected to an
active network. Make sure that you have the correct print driver software installed on your computer. For
details, see Installing the Software on page 36.

1. Select the appropriate paper.

2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type.

3. Access the print settings in your software application. For most software applications, press CTRL+P
for Windows, or CMD+P for Macintosh.

4. Select your printer from the list.

5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox®
Features for Macintosh. The title of the button can vary depending on your application.

6. Modify the print driver settings as necessary, then click OK.

7. Click Print to send the job to the printer.

See also:

Loading Paper on page 47

Selecting Printing Options on page 67

Printing on Both Sides of the Paper on page 71

Printing on Special Paper on page 56

66
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This section includes:

®  PLINE DIIVEN HEIP oottt ses e ssss st ss s ss b sas s s b s bbb s s s bas bbb s b e st sess b st sanes 67
®  WiINAOWS PriNtING OPLIONS ..c..cooevereereeeeiesissessiesessissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnssssssssssssasssessas 68
o MaCiNtOSh PriNtiNG OPLIONS ...t sessssss st ssssssssssssssssasssssssssssssssssssssssssssssssssssssssssassasssssses 69

Printing options, also called print driver software options, are specified as Printing Preferences in
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences
become the default setting. Printing options that are set from within the software application are
temporary. The application and the computer do not save the settings after the application is closed.

Print Driver Help

Xerox® print driver software Help information is available from the Printing Preferences window. Click the
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help.
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Information about Printing Preferences appears in the Help window on two tabs:

e Contents provides a list of the tabs at the top and the areas at the bottom of the Printing

Preferences window. Use the Contents tab to find explanations for each of the fields and areas in
Printing Preferences.

e Search provides a field where you can enter the topic or function for which you need information.
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Windows Printing Options

Setting Default Printing Options for Windows

When you print from any software application, the printer uses the print job settings specified in the
Printing Preferences window. You can specify your most common printing options and save them so that
you do not have to change them every time you print.

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in
Printing Preferences.

To select default printing options:
1. Navigate to the list of printers on your computer:
—  For Windows XP SP1 and later, click Start > Settings > Printers and Faxes.
—  For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers.
—  For Windows Server 2003 and later, click Start > Settings > Printers.
—  For Windows 7, click Start > Devices and Printers.
2. Inthe list, right-click the icon for your printer and click Printing Preferences.
3. Inthe Printing Preferences window, click a tab, select the options, then click OK to save.

Note: For more information about Windows print driver options, click the Help button (?) in the
Printing Preferences window.

Selecting Printing Options for an Individual Job for Windows

To use special printing options for a particular job, change the Printing Preferences from the application
before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode
when printing a particular document, select Enhanced in Printing Preferences before printing the job.

1. With the document open in your software application, access the print settings. For most software
applications, click File > Print or press CTRL+P for Windows.

2. Select your printer and click the Properties or Preferences button to open the Printing Preferences
window. The title of the button can vary depending on your application.

3. Click a tab in the Printing Preferences window, then make selections.
4.  Click OK to save and close the Printing Preferences window.
5. Click Print to send the job to the printer.

Selecting Finishing Options for Windows

If your printer has a finisher installed, you can select finishing options in the Printing Preferences of the
print driver.

To select finishing options in the PostScript and PCL print drivers:

1. Inthe print driver, click the Paper/Output tab.

2. Toselect stapling options, click the arrow to the right of the Stapling field and select an option:
— None stacks the print job without stapling the sets.
— 1 Staple puts a staple in the top left corner of each set.
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To select the output tray, click the arrow to the right of the Output Destination field, then select an

option:

—  Automatically Select determines the output destination by the number of sets and the
stapling option selected. Multiple sets or stapled sets are sent to the finisher output tray.

—  Top Tray selects the output tray on top of the printer.

—  Stacker Tray selects the finisher output tray.

Do one of the following:

— To save the settings, click Saved Settings at the bottom of the Printing Preferences window,
then click Save As.

— Tosend the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Windows

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

1.
2.

With the document open in your application, click File > Print.

Select the printer, then click Properties. Click the tabs in the Printing Properties window and select
the desired settings.

Click Saved Settings at the bottom of the Printing Properties window, then click Save As.

Type a name for the set of printing options, then click OK to save the set of options in the Saved
Settings list.

Select the name from the list to print using these options.

Macintosh Printing Options

Selecting Printing Options for Macintosh

To use specific printing options, change the settings before sending the job to the printer.

1.

vt WwN

With the document open in your application, click File > Print.
Select your printer from the list.

Select Xerox® Features from the Copies & Pages menu.
Select the desired printing options from the drop-down lists.
Click Print to send the job to the printer.

Selecting Finishing Options for Macintosh

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver.

To select finishing options in the Macintosh print driver:

1.
2.

In the print driver, click Copies & Pages, then select Xerox® Features.

To select stapling options, click the arrow to the right of the Stapling field and select an option:
— None stacks the print job without stapling the sets.

— 1 Staple puts a staple in the top left corner of each set.
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To select the output tray, click the arrow to the right of the Output Destination field, then select an

option:

—  Automatically Select determines the output destination by the number of sets and the
stapling option selected. Multiple sets or stapled sets are sent to the finisher output tray.

—  Top Tray selects the output tray on top of the printer.

—  Stacker Tray selects the finisher output tray.

Do one of the following:

— To save the settings, click Saved Settings at the bottom of the Printing Preferences window,
then click Save As.

— Tosend the job to the printer, click Print.

Saving a Set of Commonly Used Printing Options for Macintosh

You can define and save a set of options, so that you can apply them to future print jobs.

To save a set of printing options:

AN S e

70

With the document open in your application, click File > Print.

Select your printer from the Printers list.

Select the desired printing options from the drop-down lists in the Print dialog box.

Click Presets > Save As.

Type a name for the printing options, then click OK to save the set of options in the Presets list.
To print using these options, select the name from the Presets list.
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Printing Features

This section includes:
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Printing on Both Sides of the Paper

Paper Types for Automatic 2-Sided Printing

The printer can automatically print a 2-sided document on supported paper. Before printing a 2-sided
document, verify that the paper type and weight are supported.

Paper weights from 60 g/m? through 122 g/m? can be used for automatic 2-sided printing. For details,
see Supported Paper Types and Weights for Automatic 2-Sided Printing on page 45.
Printing a 2-Sided Document

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings
for portrait or landscape orientation from the application for printing the document.
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2-Sided Page Layout Options

You can specify the page layout for 2-sided printing, which determines how the printed pages turn.
These settings override the application page orientation settings.

=
5 o
I_ép > E) |__§_E

Portrait Portrait Landscape Landscape
2-Sided Print 2-Sided Print, Flip on Short | 2-Sided Print 2-Sided Print, Flip on Short
Edge Edge

Selecting Paper Options for Printing

There are two ways to select the paper for your print job. You can let the printer select which paper to
use based on the document size, paper type, and paper color you specify. You can also select a specific
tray loaded with the desired paper.

Printing Multiple Pages to a Single Sheet (N-Up)

When printing a multiple-page document, you can print more than one page on a single sheet of paper.
Print 1, 2, 4,6, 9, or 16 pages per side by selecting Pages Per Sheet (N-Up) on the Layout/Watermark tab.
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Printing Booklets

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and
prints four page images per sheet of paper, two page images on each side. The pages are printed in the
correct order so that you can fold and staple the pages to create the booklet.

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter

and creep.

e  Gutter specifies the horizontal distance in points between the page images. A point
is 0.35 mm (1/72in.).

e Creep specifies how much the page images are shifted outward, in tenths of a point. Shifting
compensates for the thickness of the folded paper, which would cause the page images to shift
slightly outward when folded. You can select a value from zero to 1 point.

|2 3
/

Using Color Options

The Color Options control the way the printer uses color to produce your document. The Windows
PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each
system has three standard modes of color control for normal use and Custom Color Options for the more
advanced users.

The three standard color modes are:

e Automatic Color applies the best color correction to text, graphics, and images. This setting is
recommended.

e  Vivid Color applies automatic color correction to make office colors more saturated.

e Black and White converts all color in the document to black and white or shades of gray.

ColorQube 8700/8900 Color Multifunction Printer 73
User Guide



Printing

Custom Color Options provide three ways of adjusting the colors for more specific color requirements.
Click the Custom Color Options bar to open the Custom Color Options window:

Color By Words provides a three step process for defining custom color correction. By making a
selection from each of the three fields, you create a sentence for controlling the color characteristics
of the document. You can create several sentences to more precisely control the color content of the
document.

The sentence structure is made of three parts:

—  What Color to Change? provides a drop-down list to select a color or range of colors to adjust,
such as All Foliage-Green Colors.

—  How Much Change? lets you select how much effect to make, such as A Lot More, to the
selected color.

—  What Type of Change? lets you select the type of change, such as Vivid, from the drop-down
list.

As you create a Color By Words sentence, it appears in the window below the selection fields.

Color Correction provides a list of commercial press, spot color, CIE, and gray image simulations

from which you can select to match your document color.

Color Adjustments provides a set of six sliders for adjusting the individual components of the

selected colors. Use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and

yellow components of the color.

Printing Cover Pages

A cover page is the first or last page of a document. You can select paper sources for the cover pages
that are different from the source used for the body of a document. For example, you can use your
company letterhead for the first page of a document. You can also use heavyweight paper for the first
and last pages of a report. You can use any applicable paper tray as the source for printing cover pages.

Select one of these options for printing cover pages:

No Covers does not print cover pages. No cover pages are added to the document.
Front Only prints the first page on paper from the specified tray.

Back Only prints the back page on paper from the specified tray.

Front and Back: Same prints the front and back cover pages from the same tray.
Front and Back: Different prints the front and back cover pages from different trays.

After making a selection for printing the cover pages, you can select the paper for the front and back
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side
two, or both sides of the cover pages.
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Printing Insert Pages

You can add blank or pre-printed insert pages before page one of each document or after designated
pages within a document. Adding an insert after designated pages within a document separates
sections, or acts as a marker or placeholder. Make sure that you specify the paper to use for the insert

pages.
e Insert Options provides the options to place an insert After Page X, where X is the specified page, or
Before Page 1.

e Insert Quantity specifies the number of pages to insert at each location.

e Page(s) specifies a page or a range of pages after which you want an insert added. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to add inserts after pages 1, 6,9, 10, and 11, type: 1, 6, 9-11.

e  Paper displays the default size, color, and type of paper selected in Use Job Settings for the insert
pages. Use the down arrow to the right of the Paper field to select a different paper by size, color, or

type.
e Job Settings displays the attributes of the paper selected for the print job, without the inserts.

Note: Add Inserts is not available when Page Layout is set to Booklet Layout.

Printing Exception Pages

Exception pages have different settings from the rest of the pages in the job. You can specify differences
such as page size, page type, and page color. You can also change the side of the paper on which to print
as your job requires. A print job can contain multiple exceptions.

For example, your print job contains 30 pages. You want five pages to print on only one side of a special
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to
print the job.

In the Add Exceptions window, you can set the characteristics of the exception pages and select the
alternate paper source:

e  Page(s) specifies the page or range of pages that use the exception page characteristics. Separate
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For
example, to specify pages 1, 6,9, 10, and 11, type 1,6,9-11.

e  Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down
arrow to the right of the Paper field to select a different paper size, color, or type.

e  2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an
option:
— 1-Sided Print prints the exception pages on one side only.

—  2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the
long edge. The job then can be bound on the long edge of the pages.

—  2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and
flips the pages on the short edge. The job then can be bound on the short edge of the pages.

e Job Settings displays the attributes of the paper for the remainder of the job.
Notes:

e Add Exceptions is not available when Page Layout is set to Booklet Layout.

e  Some combinations of 2-sided printing with certain paper types and sizes can produce
unexpected results.
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Scaling

You can reduce the image to as little as 25 % of its original size or enlarge it as much as 400 % . The
default setting is 100 % .

50% 100% 200%

XEROX

XEROX

In Windows, the Scale Options are located in the print driver on the Paper/Output tab in the Paper field.
Click the arrow at the right side of the Paper field and select Other Size to access the Scale Options:

e No Scaling does not increase or decrease the size of the image from the original.

e Automatic Scaling changes the print from one standard paper size to another standard paper size.
The Original Document Size is scaled to fit on the selected output paper size shown in the Output
Paper Size field.

e  Manual Scaling changes the output print size by the percentage entered into the field under the
graphic to the right of the Scale Options.

Printing Watermarks

A watermark is special purpose text that can be printed across one or more pages. For example, you can
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before
distribution.
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Using the watermark options, you can do the following:

Create a watermark or edit an existing watermark using the Watermark Editor:

— Name allows you to give the new watermark a unique name.

—  Options enables you to use text, time stamps, or graphics for the watermark.

—  Text provides a field in which you enter the text to be printed as the watermark.

—  Font and Color determine the font, size, style, and color of the watermark.

— Angle sets the degree of rotation applied to the text or graphics used for the watermark.
— Density defines how faint or how prominent the watermark appears on the pages.

—  Position from center determines the position of the watermark on the page. The default
position is in the center of the printed pages.

Place a watermark on the first page or on every page in a document.
Print a watermark in the foreground or background or blend it with the print job.

Printing Mirror Images

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right
when printed.

Creating and Saving Custom Paper Sizes

You can print custom-size paper from Tray 1 only. Custom-size paper settings are saved in the print
driver and are available for you to select in all your applications. For paper sizes that are supported for
each tray, see Supported Custom Paper Sizes on page 42.

To create and save custom sizes for Windows:

1.
2.
3.
4,

Click the Paper/Output tab of the print driver.

Click the arrow at the right of the Paper field, then select Other Size > Output Paper Size > New.
In the New Custom Size window, enter the height and width of the new size, then select the units.
Enter a title for the new size in the Name field, then click OK to save.

To create and save custom sizes for Macintosh:

ot whN-~

In the application, click File > Page Setup.

Click Paper Sizes, then select Manage Paper Sizes.

To add a new size, in the Manage Paper Sizes window, click the plus sign (+).

Double-click Untitled at the top of the window and type a name for the new custom size.
Enter the height and width of the new custom size.

Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set
the top, bottom, right, and left margins for User Defined margins.

To save the settings, click OK.
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Selecting Job Completion Notification for Windows

You can select to be notified when your job finishes printing. A message appears on your computer
screen with the name of the job and the name of the printer where it was printed.

Note: This feature is only available on a Windows computer printing to a network printer.

To select job completion notification:

1. Inthe print driver, click More Status at the bottom of any tab.

2. Inthe Status window, click Notification, then click the desired option.
3. Close the Status window.

Printing Special Job Types

Special job types allow you to send a print job from your computer, then print it from the printer control
panel. Select special job types in the Printing Preferences of the print driver.

Secure Print

Secure print allows you to associate a 4—10 digit passcode with a print job when sending it to the printer.
The job is held at the printer until you enter the passcode at the control panel.

When printing a series of secure print jobs, you can assign a default passcode in the Printing Preferences
of the print driver. Then you can use the default passcode for all print jobs sent from that computer. If
you must use a different passcode, you can override it in the application print driver.

Sending a Secure Print Job

1. On the Paper/Output tab, from the Job Type list, select Secure Print.
2. Type then retype a 4-10 digit passcode for the secure print job.

3. Inthe Confirm Passcode field, type the passcode again.

Notes:

e If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode
Required window. Use this passcode to print the document at the printer, or click Cancel and type
your own passcode to use in the Secure Print window.

e The passcode is associated with your user name. After you set a passcode, it becomes the default
passcode for any print job that requires a passcode on all Xerox® printers. You can reset the
passcode at any time from any window that contains the passcode.

4. Click OK.
5. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

6. Select an option for 2-sided printing.

7. If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.

8. Select a print-quality mode.
9. Select an output destination.
10. Click Apply, then select another tab, or click OK.

78 ColorQube 8700/8900 Color Multifunction Printer
User Guide



Printing

Releasing a Secure Print

1. At the control panel, press the Job Status button.

2. Touch the Secure Print tab.

3. Touch the corresponding print job in the list, then touch Release.

4. Enter the passcode number that you assigned to the print job using the keypad.
5. Tostart printing, touch Release Job.

Sample Set

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the
remaining copies at the printer. After you review the sample copy, you can select the job name from the
printer control panel to print the additional copies.

Sending a Sample Set Print Job

1.
2.

9.
10.

On the Paper/Output tab, from the Job Type list, select Sample Set.
Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

Select an option for 2-sided printing.

If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.

Select a print-quality mode.
Select an output destination.

To send the job to the printer, in the Print window, select the number of copies to print, then click
OK or Print.

A sample copy prints immediately. The sample copy is not counted as part of the print job.
After reviewing the copy, use the printer control panel to print or delete the remaining copies.

Note: You can use Sample Set as a part of the Earth Smart settings. In Earth Smart settings, set
Sample Set as your default Job Type.

To print the job, select it from the job list on the printer control panel.
Press OK.

Releasing the Remainder of Prints After Printing a Sample Set

1.
2.

At the control panel, touch Jobs.
Touch the corresponding print job in the list.

Note: The control panel displays Held: Sample Set next to the job name.

Touch Release.
The remainder of the job prints, and the job is deleted from the printer hard drive.
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Delay Print

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at
which you would like the job to print. If the time you enter is earlier than the time that you submit the
print job, it prints on the following day. The Delayed Print default time is midnight.

Sending a Delay Print Job

1.  On the Paper/Output tab, from the Job Type list, select Delay Print.

2. Inthe Delay Print window, select the Tab key to move from the hour section to the minutes section.
To select the time to send the print job, click the Arrow buttons.
—  For a12-hour time format, type the hour (1-12), minutes (00-59), then select A.M. or P.M. To

toggle between A.M. and P.M,, click the Up Arrow or Down Arrow buttons.

—  For a 24-hour time format, type the hour (1-23), and the minutes (00-59).
Note: The regional settings on your computer determine the time format.

3. Click OK.

4. Select other desired printing options and click OK.

5. Click OK or Print.
Note: To print the job after you send it but before the scheduled time, release the job at the printer
control panel.

Saved Job

Saved Job or Store File in Folder stores a public or private job in the printer and prints the job as
requested at the printer control panel. This option is useful for documents that you print frequently. You
can assign a passcode to a private job to prevent unauthorized printing.

To print saved jobs, see Printing from Saved Jobs on page 83.

Sending a Public Saved Job

1.
2.
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On the Paper/Output tab, from the Job Type list, select Saved Job.

In the Saved Job window, for Job Name, do one of the following:

—  Type a name for the job.

—  Click the arrow to the right of the field and select a name from the list.

—  Click the arrow to the right of the field and select Use Document Name to use the name of the
document.

The print driver retains 10 names. When adding an 11th name, the name used least is deleted
automatically from the list. To remove names from the list other than the selected name, select
Clear List.

—  For Folder, do one of the following:

Select Public.

Click OK.

Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

Select an option for 2-sided printing.
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7. If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.

8. Select a print-quality mode.

9. Click OK or Print.

10. To print the job, select it from the job list on the printer control panel.
11. Press OK.

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on
page 83.

Sending a Private Saved Job
1.  On the Paper/Output tab, from the Job Type list, select Saved Job.
2. Inthe Saved Job window, for Job Name, do one of the following:
—  Type a name for the job.
—  Click the arrow to the right of the field and select a name from the list.

—  Click the arrow to the right of the field and select Use Document Name to use the name of the
document.

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted
automatically from the list. To remove names from the list other than the selected name, select
Clear List.

—  For Folder, do one of the following:
3. Tostore your job at the printer, select Private.

4. Inthe Passcode field, type a passcode. The passcode is associated with your user name. After you
set a passcode, it becomes the default passcode for any print job that requires a passcode on all
Xerox® printers. You can reset the passcode at any time from any window that contains the
passcode.

Notes:

e If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode
Required window. Use this passcode to print the document at the printer, or click Cancel and type
your own passcode to use in the Secure Print window.

e The passcode is associated with your user name. After you set a passcode, it becomes the default
passcode for any print job that requires a passcode on all Xerox® printers. You can reset the
passcode at any time from any window that contains the passcode.

5. Click OK.
6. Verify that the paper is the correct size, type, and weight. If not, change the paper settings.

Note: You can select the paper for your print job using Select By Tray.

7. Select an option for 2-sided printing.

8. If your printer has a finisher installed, select a stapling option. The image next to Stapling displays
the staple position.
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9. Select a print-quality mode.

10. Click OK.

11. To print the job, select it from the job list on the printer control panel.
12. Press OK.

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on
page 83.

Held Print Jobs

Jobs can be held or paused for various reasons. For example, if the printer is out of paper, the job holds.
If you send a sample job, the first copy of the job prints and the rest of the copies hold until you release
them. If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is
held until you release it.

Releasing Held Print Jobs

1. Atthe control panel, press the Job Status button.
2. Touch Active Jobs.
—  Todetermine why a job was held, touch the job, then touch Job Details.

— Torelease a held job, touch the job, then touch Release. To release all held jobs, touch Release
All Jobs.

Print From

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB
Flash drive.

Printing from a USB Flash Drive

You can print .pdf, .tiff, .ps, and .xps files directly from a USB Flash drive. If USB ports are disabled, you
cannot use a USB card reader for authentication, or print or update software from a USB Flash drive.

The system administrator must set up this feature before you can use it. For details, see the System
Administrator Guide for your printer model:

e  ColorQube 8700 Color Multifunction Printer: www.xerox.com/office/CQ8700docs
e  ColorQube 8900 Color Multifunction Printer: www.xerox.com/office/CQ8900docs

To print from a USB Flash drive:
1. Insert the USB Flash drive into the control panel USB port. The Print from USB window appears.
The list at the bottom of the window displays the contents of the USB Flash drive.

Note: If the USB Flash drive is already in the USB memory port, touch Print From > USB Drive.

2. Use the arrows to the right of the list to scroll through the list and locate the printable file.
If the print file is in a folder, touch the name to open the folder.
3. Touch the name of the printable file.
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4. Select the number of copies and the paper size, color, and type for the print job.

5. Press the green Start button.
To go back to the last screen, touch Back.
To look for other folders and printable files, touch Browse.

Printing from Saved Jobs

For details about sending saved jobs, see Saved Jobs on page 80.

To print from saved jobs:
1. At the control panel, touch Print From.

2. Select Saved Jobs, then touch the name of the folder containing the saved job.

Printing

3.  Touch the name of the saved job you want to print, then select paper size, 2-sided printing, and

finishing options.

Note: To print a private saved job, touch the name of the job, then enter the passcode.

4. Press the green Start button.
After the job prints, to return to the list of saved jobs, touch Browse.
To return to the list of folders, touch Back.

Printing from Mailbox

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive.

To print from a mailbox:
1. At the control panel, touch Print From.
2. Select Mailbox, then touch the name of the folder containing the document.

3.  Touch the name of the document you want to print, then select the paper size, 2-sided printing, and

finishing options.
4. Press the green Start button.

After the job prints, to return to the list of documents in the mailbox, touch Browse.

To return to the list of folders, touch Back.

ColorQube 8700/8900 Color Multifunction Printer

User Guide

83



Printing

Printing from CentreWare Internet Services

You can print .pdf, .ps, .pcl, and .xps files directly from CentreWare Internet Services without having to
open another application or the print driver. The files can be stored on a local computer hard drive, mass
storage device, or network drive.

To print from CentreWare Internet Services:

1.

84

At your computer, open a Web browser, in the address field, type the IP address of the printer, then
press Enter or Return.

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on
page 26.

In CentreWare Internet Services, click Print.
The Job Submission page appears.

Type the name of the file in the File Name field, or click Browse to select the file from a local
network or remote location.

Under Printing, select the desired options for the job.
Click Submit Job to print the document.

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation
message to appear before you close this page.
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Basic Copying

1. To clear previous settings, press the yellow Clear All button on the control panel.
2. Load your original documents:

—  Use the document glass for single pages or paper that cannot be fed using the document
feeder. Place the first page of the document face down, in the top left corner of the document
glass.

—  Use the document feeder for multiple or single pages. Remove any staples and paper clips from
the pages and place them face up in the document feeder.

3. Press the Services Home button, then touch Copy.
4. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of
copies appears in the upper right corner of the touch screen.

Note: To correct the number of copies entered using the alphanumeric keypad, press the C button,
then re-enter the number.

5. Change the copy settings as needed. For details, see Selecting Copy Settings on page 88.
6. Press the green Start button.

Notes:

e To pause or cancel a copy job, press the red Stop button on the control panel.
e Tointerrupt a copy job, press the Interrupt button on the control panel.

e  On the touch screen, touch Resume Scanning to continue the job, or Cancel Scanning to cancel
the job completely.

Document Glass

e Lift the document feeder cover and place the
first page face down in the upper left corner of
the document glass.

e Align the originals to the matching paper size
printed on the edge of the glass.

e The document glass accepts paper sizes up to
297 x 432 mm (11.7 x17 in.).

e The document glass automatically detects
standard paper sizes.
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Copying

Insert originals face up, with page one on top.

The confirmation indicator illuminates when
you load the originals correctly.

Adjust the paper guides so they fit against the
originals.

The document feeder accepts paper weights
38-128 g/m?for 1-sided pages, and

50-128 g/m?for 2-sided pages.

The document feeder accepts paper sizes from
85x 125 mm (3.3 x 4.9 in.) through 297 x
432 mm (11.7x17 in.) for 1-sided pages,
and 110 x 125 (4.3 x 4.9 in.) through 297 x
432 mm (11.7 x 17 in.) for 2-sided pages.

The maximum feeder capacity is
approximately 110 sheets of 80 g/m? paper.

The document feeder automatically detects
standard paper sizes.
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Selecting Copy Settings

This section includes:
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Basic Settings

This section includes:
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Selecting Color or Black and White Copies

If the original document contains color, you can create copies in full color, a single color, or in black and
white.

To select the output color:

1.
2.

3.

Press the Services Home button, then touch Copy.

Under Output Color, select an option:

—  Auto Detect detects the color content in the original document. If the original is a color
document, the printer makes copies in full color. If the original is a black and white document,
the printer makes copies in black only.

—  Black & White copies in black and white only. Colors in the original are converted to shades of
gray.

—  More provides additional choices:

e  Color copies in full color output using all four printing colors, cyan, magenta, yellow, and
black.

e Single Color copies in shades of a single color. Under Colors, select a color. The sample
page shows your color selection.

Touch OK.
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Reducing or Enlarging the Image

You can reduce the image to as little as 25 % of its original size or enlarge it as much as 200 % . When
using ID Card Copying, you can enlarge to 400 % of the original size.

To reduce or enlarge the image:

1. Press the Services Home button, then touch Copy.

2. Touch an option:

—  Toreduce or enlarge the percentage incrementally, under Reduce/Enlarge, touch Plus (+) or
Minus (-).

—  Toreduce or enlarge the percentage using the alphanumeric keypad to type a specific value,
under Reduce/Enlarge, touch the current displayed value.

—  Toreduce or enlarge proportionally, touch Reduce/Enlarge, then touch Proportional %.

To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-).

To reduce or enlarge the percentage using the alphanumeric keypad, touch the current
displayed value.

Presets (X-Y%) allow you to select from a list of preset values. Touch More for additional
preset values.

To center the image on the page, select the Auto Center check box.

—  Toreduce or enlarge the width and length of the image by different percentages, touch
Reduce/Enlarge, then touch Independent %.

Width:X% allows you to reduce or enlarge the width of the image incrementally using the
alphanumeric keypad or the Plus (+) and Minus (-) buttons.

Length:Y% allows you to reduce or enlarge the length of the image incrementally using
the alphanumeric keypad or the Plus (+) and Minus (-) buttons.

Presets (Y/X) allow you to select from a list of preset values. Touch More for additional
preset values.

To center the image on the page, select the Auto Center check box.

3. Touch OK.

Selecting the Paper Tray

Select a paper tray loaded with the desired paper to make copies on letterhead, colored paper,
transparencies, or different paper sizes.

To select the tray to use for copies:

1. Press the Services Home button, then touch Copy.

2. Under Paper Supply, touch the desired tray.

3. If the desired tray is not listed, select another tray:

a. Touch More for additional options.
b. Touch the desired tray.
4.  Touch OK.
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Selecting 2-Sided Copy Options
Use the document feeder or the document glass to copy one or both sides of a 2-sided original.

To select 2-sided copy options:
1. Press the Services Home button, then touch Copy.
2. Under 2-Sided Copying, select one of the following:
— 1->1 Sided scans only one side of the originals and produces 1-sided copies.

— 1->2 Sided scans only one side of the originals and produces 2-sided copies. To rotate the
second sides, touch Rotate Side 2.

—  2->2 Sided scans both sides of the originals and produces 2-sided copies. To rotate the second
sides, touch Rotate Side 2.

—  2->1 Sided scans both sides of the originals and produces 1-sided copies.
3. Press the green Start button.
—  The document feeder automatically copies both sides of the 2-sided original.

— A message appears on the control panel when it is time to place the next original on the
document glass.

Selecting Collated Copies

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a
six-page document, the copies are printed in this order:

1,2,3,4,56;1,2,3,4,5,6;1,2,3,4,5,6

To select collated copies:
1. Press the Services Home button, then touch Copy.
2. Under Copy Output, touch Collated if it is not already selected.

Selecting Uncollated Copies

Uncollated copies print in the following order:
1,1,1,2,2,2,3,3,3,4,4,4,5,5,5,6,6,6

To select uncollated copies:
1. Press the Services Home button, then touch Copy.
If your printer has a finisher, under Copy Output, touch More.
2. Under Collation, touch Uncollated.
3. Touch OK.
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Image-Quality Settings

This section includes:
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Specifying the Original Type

The printer optimizes the image quality of the copies based on the type of images in the original
document and how the original was created.

To specify the original type:

1. Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Original Type.

3.  Onthe Original Type screen, select the appropriate settings:
—  Onthe left side of the screen, touch the content type of the original document.
—  If known, select how the original was produced.

4.  Touch OK.

Adjusting Brightness, Sharpness, and Saturation
You can lighten or darken copies and adjust the sharpness and saturation.

To adjust the image:

1. Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Image Options.

3. Onthe Image Options screen, adjust the sliders up or down as needed:
— Lighten/Darken lightens or darkens the image.
—  Sharpness sharpens or softens the image.
—  Saturation makes the image colors more vivid or pastel.

4. Touch OK.
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Automatically Suppressing Background Variation

When scanning originals printed on thin paper, text or images printed on one side of the paper can be
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to
variations in light background colors.

To change this setting:

1. Press the Services Home button, then touch Copy.

2. Touch the Image Quality tab, then touch Image Enhancement.
3. Under Background Suppression, touch Auto Suppression.

4. Touch OK.

Adjusting the Contrast
Contrast is the relative difference between light and dark areas in an image.

To increase or reduce the contrast of the copies:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Image Enhancement.
3. Onthe Image Enhancement screen, adjust the contrast:
—  Auto Contrast allows the printer to set the contrast automatically.

—  Manual Contrast allows you to adjust the contrast manually. To increase or decrease the
contrast, move the Manual Contrast slider up or down. The middle position on the slider,
Normal, does not change the contrast.

4. Touch OK.

Selecting Color Effects

If you have a color original, you can adjust the color of the copy using preset color effects. For example,
you can adjust colors to be brighter or cooler.

To select a preset color effect:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Color Presets.

Note: This feature is not available when Output Color is set to Black and White.

3. On the Color Presets screen, touch the desired preset color effect. The sample images show how the
colors are adjusted.

4. Touch OK.
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Adjusting the Color Balance

If you have a color original, you can adjust the balance of the printing colors between cyan, magenta,
yellow, and black before printing your copy.

To adjust the color balance:
1. Press the Services Home button, then touch Copy.
2. Touch the Image Quality tab, then touch Color Balance.

Note: This feature is not available when Output Color is set to Black and White.

3. To adjust the density levels of all four colors:
a. On the Color Balance screen, touch Basic Color.
b. Move the sliders to adjust the level for each color.
4. To adjust the highlight, midtone, and shadow density levels by color:
a. On the Color Balance screen, touch Advanced Color.
b. Touch the color you want to adjust.
¢. Move the sliders to adjust the levels for highlights, midtones, and shadows.
d. Repeat the previous two steps for additional colors.
5. Touch OK.
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Layout Settings

This section includes:
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Specifying the Orientation of the Original

If you plan to have the copies automatically stapled, specify the orientation of the original.

1.
2.
3.

Press the Services Home button, then touch Copy.

Touch the Layout Adjustment tab, then touch Original Orientation.

On the Original Orientation screen, touch the desired orientation:

—  Portrait Originals and Landscape Originals refer to the images on the originals.

— Upright Images and Sideways Images refer to the direction the originals are loaded in the
document feeder.

Note: If you are using the document glass, the orientation of the original is as seen before turning it
over.

Touch OK.

Specifying the Size of the Original

To scan the correct area of the original, specify the original size.

1.
2.
3.

Press the Services Home button, then touch Copy.

Touch the Layout Adjustment tab, then touch Original Size.

On the Original Size screen, select an option:

—  Auto Detect allows the printer to determine the size of the original.

—  Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the
scrolling list, touch the desired paper size.

—  Custom Scan Area allows you to specify the height and width of the area to scan. To specify
an areaq, touch the Length (Y) and Width (X) arrows.

— Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the
diagram on the screen to determine which original sizes can be mixed in the same job.

Touch OK.
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Selecting Book Copying

When copying a book, magazine, or other bound document, you can copy either the left or right page
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or as
a single image on one sheet of paper.

Note: You must use the document glass to make copies from books, magazines, or other bound
documents. Do not place bound originals in the document feeder.

To set up book copying:
1. Press the Services Home button, then touch Copy.
2. Touch the Layout Adjustment tab, then touch Book Copying.
3. Onthe Book Copying screen, select an option:
—  Off copies both pages of an open book as one image on a single sheet of paper.

— Both Pages copies the left and the right pages of an open book onto two sheets of paper. If
Binding Edge Erase is required, touch the arrows to erase up to 50.8 mm (2 in.).

—  Left Page Only copies only the left page of an open book on a single sheet of paper. If Binding
Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.).

— Right Page Only to copy only the right page of an open book on a single sheet of paper. If
Binding Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.)

4. Touch OK.

Shifting the Image

You can change the placement of an image on the copy page. This is useful if the image is smaller than
the page size. Originals must be positioned as follows for image shift to work correctly:

e Document Feeder: Position originals face up, long edge entering the feeder first.

e Document Glass: Position originals face down, in the back-left corner of the document glass, long
edge to the left.

To change the placement of the image:
1.  Press the Services Home button, then touch Copy.
2. Touch the Layout Adjustment tab, then touch Image Shift.
3. Onthe Image Shift screen, select an option:
—  Auto Center centers the image on the page.

—  Margin Shift allows you to specify the position of the image. To specify the amount of shift for
Side 1, touch the Up/Down and Left/Right arrows. To specify the amount of shift for Side 2,
touch the Up/Down and Left/Right arrows, or select Mirror Side 1.

Note: You can use preset values that were previously saved by the system administrator. Touch
Presets in the lower left corner of the screen, and select a preset from the drop-down menu.

4. Touch OK.
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Erasing the Edges of Copies

You can erase content from the edges of your copies by specifying the amount to erase on the right, left,
top, and bottom edges.

To erase edges on copies:

1.
2.
3.

Press the Services Home button, then touch Copy.
Touch the Layout Adjustment tab, then touch Edge Erase.
On the Edge Erase screen, select an option:

— All Edges erases all four edges by the same amount. To specify the amount to erase from the
edge, touch the All Edges arrows.

— Individual Edges specifies different amounts for the edges. To specify the amount to erase
from each edge, touch Side 1, then touch the Left, Right, Top, and Bottom arrows. To specify
the amount to erase from each edge, touch Side 2, then touch the Left, Right, Top, and
Bottom arrows, or touch Mirror Side 1.

Note: You can use preset values that were previously saved by the system administrator. Touch
Presets in the lower left corner of the screen, and select a preset from the drop-down menu.

Touch OK.

Inverting the Image

You can invert your original, as a mirror image or as a negative image. You can use one or both of these
options.

To invert the image:

1.
2.
3.

Press the Services Home button, then touch Copy.

Touch the Layout Adjustment tab, then touch Invert Image.
On the Invert Image screen, select an option:

—  Mirror Image reflects each image left to right on the page.
— Negative Image reverses the black and white values.
Touch OK.
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Output Format Settings

This section includes:
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Creating a Booklet

1.

2.
3.
4

Press the Services Home button, then touch Copy.

Touch the Output Format tab, then touch Booklet Creation.
On the Booklet Creation screen, touch On.

To specify 2-sided originals:

a. Touch Original Input.

b. Touch 2-Sided Originals.

To select a paper tray:

a. Touch Paper Supply.

b. Touch the desired tray.

Touch OK.

Including Covers

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight
paper. The printer selects the paper from a different tray. The covers can be blank or printed.

Note: The paper used for the covers must be the same size as the paper used for the rest of the
document.

To select the type of covers and the tray to use for the cover paper:

1.
2.
3.

98

Press the Services Home button, then touch Copy.
Under Paper Supply, touch the tray containing the paper for the body pages of the job.
Touch the Output Format tab, then touch Special Pages.

Note: If Booklet Creation is turned off or the paper supply is set to Auto Select, Special Pages are
unavailable.

On the Special Pages screen, touch Covers.
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6.
7.
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Under Covers Options, select an option:

—  Front & Back Same includes front and back covers from the same tray.

—  Front & Back Different includes a front and a back cover from different trays.
From the drop-down menus that appear, select options for the front and back covers:
e Blank Cover inserts a blank cover.
e  Print on Side 1 prints on the front side of the cover.

e  Print on Side 2 prints on the back side of the cover. To rotate the image on side 2 by
180 degrees, touch Rotate Side 2.

e  Print on Both Sides prints on both sides of the cover. To rotate the image on Side 2 by
180 degrees, touch Rotate Side 2.

—  Front Only includes only a front cover.
—  Back Only includes only a back cover.
Under Paper Supply, touch the desired tray.
Touch OK.

Specifying Chapter Start Pagination

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified side
of the paper.

To set the start side of particular pages:

1.
2.

L N

Press the Services Home button, then touch Copy.
Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, Chapter Starts is unavailable.

Touch the Output Format tab, then touch Special Pages > Chapter Starts.

On the Chapter Starts screen, touch the Page Number field, then use the alphanumeric keypad to
enter the page number.

Under Start Chapter, select an option:

— On Right Page specifies the front side of the paper.

—  On Left Page specifies the back side of the paper.

Touch Add. That page is added to the list on the right side of the screen.
Repeat the three previous steps to set other pages.

Touch Close. The page settings appear in the list on the right side of the screen.
Touch OK.
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Adding Inserts

You can insert blank pages or pre-printed sheets in specific locations in your copy job. You must specify
the tray containing the inserts.

Note: The paper used for the inserts must have the same width as the paper used for the rest of the
document. Inserts cannot be added if Booklet Creation is selected.

To add inserts:
1. Press the Services Home button, then touch Copy.
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job.

Note: If the paper supply is set to Auto Select, inserts cannot be added.

3. Touch the Output Format tab, then touch Special Pages > Inserts.

4. Onthe Inserts screen, touch the After Page Number field, then use the alphanumeric keypad to
enter the page number.

5.  To specify the number of sheets to insert at that location, touch the Insert Quantity arrows.
6. To specify the paper tray to use for the insert:
a. Touch Paper Supply.
b. Touch the desired tray.
c¢. Touch OK.
7. Touch Add. The insert appears in the list on the right side of the screen.
8. Repeat the three previous steps to add additional inserts.
9. Touch Close. The inserts appear in the list on the right side of the screen.

Note: To edit or delete an insert, touch the insert in the list, then touch an action in the drop-down
menu.

10. Touch OK.

Specifying Exception Pages

You can print exception pages in a copy job using paper from a different tray. The paper used for the
exception pages must be the same size as the paper used for the rest of the document.

Note: You cannot add exception pages if the paper supply is set to Auto Select, 